Session One: Basic Skills

A bad beginning makes a bad ending.
Euripides, Aegeus (484 BC - 406 BC).

Even if you are a seasoned Excel user, I urge you to take Euripides’
advice and complete this session. You'll fly through it if you already
know most of the skills covered.

In my classes I often teach professionals who have used Excel for over ten
years and they always get some nugget of fantastically useful information
from this session.

In this session I teach you the absolute basics you need before you can
start to do useful work with Excel 2007.

I don’t assume that you have any previous exposure to Excel (in any
version) so I have to include some very basic skills.

If you're moving to Excel 2007 from an earlier version this session will
de-mystify Microsoft’s new fluent user interface (Ribbon).

Session Objectives

By the end of this session you will be able to:

Start Excel and check your program version

Maximize, minimize, re-size, move and close the Excel window
Understand the Application and Workbook windows

Open and navigate a workbook

Save a workbook

Pin a document and understand file organization

View, add, rename, delete and navigate worksheet tabs

Use the Ribbon

Understand Ribbon components

Customize the Quick Access Toolbar and preview the printout
Use the Mini Toolbar, Key Tips and keyboard shortcuts
Understand Views

Use full screen view

Use the help system
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Lesson 1-1: Start Excel and

check your program

version

If you are using Windows XP the procedure is almost the same as
described here. You should be able to figure out the differences!

1 Click the Windows Start Button e at the bottom left of

your screen.

2 Click the All Programs item at the bottom of the pop-up

menu.

w

Scroll down the list and click on the Microsoft Office item.

4 Pin Microsoft Office Excel 2007 to the start menu.

You'll be using Excel a lot so it makes sense to pin it to the start
menu. This will make it appear at the top of the list in future so
you'll be able to start Excel with just two clicks.

To pin to the start menu point to Microsoft Office Excel 2007 in the
list, right-click your mouse and then choose Pin to Start Menu from

the shortcut menu.

5 Left-click Microsoft Office Excel 2007 to start the application.

Excel starts and is displayed on the screen:
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6  Check the program version.

\

3

Click the Microsoft Office button

= atthe top left of the screen and

then click the Excel Options button

| 23 Excel Options

at the bottom right

of the dialog.

Click Resources from the left hand sidebar and you'll see the version

number at the bottom of the dialog:

Trust Center Let us know if you need help, or how we can make Microsoft Office better,

Resources

activate Microsoft Office

Activation is required to continue using all the features in this product.

go to Microsoft Office Online

about Microsoft Office Excel 2007
Microsoft® Office Excel® 2007 [12.0.6300.5000} SP1 MSO [12.0.6213.1000}

Excel Options [ el
Popular [l Contact Microsoft, find online resources, and maintain health and reliability of your Microsoft Office
Formulas = SRS
Proofing get updates
Save Get the latest updates available for Microsoft Office,

Advanced run Microsoft Office Diagnostics Diagnose
Customize Diagnose and repair problems with your Micros oft Office programs.
Add-Ins contact us Contact Us

Get free product updates, help, and online services at Microsoft Office Online.

Adtivate

Go Online

About
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Important

Service Packs

When Excel 2007 was first
released it had many bugs (as
do all computer programs of
any size).

Microsoft is very pro-active at
fixing bugs that are found and
always release these fixes free
of charge as a service pack.

Service packs normally only fix
bugs found in the original
program, but Microsoft
sometimes take things a little
further by including new, or at
least enhanced, features with
their service packs.

I'had many emails from readers
of my book: Learn Access VBA
2003 with the Smart Method
suggesting that some of the
examples didn’t work for them.
In almost every case the
problem was that they were
using an out-of-date version of
the application or the operating
system. After applying the
relevant service packs the
problems vanished.

For this reason it is important
that you make sure your
software is up to date.

note

What if I'm unable to
upgrade my operating
system or I'm using a
different operating
system?

Sometimes your corporate
policy will not allow you to
upgrade your operating system
or application service pack.

In this case you can still use this
book but be aware that it is
possible that some of the
features described may not
work as expected (or may not
work at all).

In this example the Excel version is:

about Microsoft Office Excel 2007

Microsoft® Office Excel® 2007 (12.0.6300.5000) 5P1 M50 (12.0.6213.1000)

The important part is the SP1 denoting that you have service pack one

installed. If this says SP2, SP3 or an even larger number this is also fine. It

simply means that Microsoft have fixed even more bugs in their product
since this book was published.

If you do not see any reference to SPn, you have an early, un-patched

version of Excel 2007 and you should update it (the update is free) via the

Internet.
7 Check the Operating System version.

Click the About Button next to about Microsoft Excel 2007. A dialog is
displayed with information about your copy of Excel.

This product is licensed to:

Product ID:

View the Microsoft Software License Terms

Warning: This computer program is protected by copyright law and international f
treaties. Unauthorized reproduction or distribution of this program, or any portion of &
it, may result in severe cvil and criminal penalties, and will be prosecuted to the . ]
maximum extent possible under the law. | System Info..., |

| Tech Support... |

Click the System Info... button. The Operating System (OS) Name and
Version will then be visible at the top right of the dialog:

Vista
Item Yalue
05 Mame Microsoft® Windows Vista™ Ultimate
Version 6.0.6001 Service Pack 1 Build 6001
Windows XP
tem Walus
25 MName Microsoft Windows XP Professional
Wersion B.1.2600 Service Pack 2 Build 2600

Once again, it doesn’t matter if you have Vista running a later service
pack than SP1 (or Windows XP running a later service pack than SP2).

If you're running Vista or Windows XP, any edition will suffice (it
doesn’t have to be the Ultimate or Professional edition).

8 Click the close button on the top right corner of each
dialog to return to the Excel screen.
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Lesson 1-2: Maximize,
minimize, re-size, move and
close the Excel window

The great successful men of the world have used their imaginations,
they think ahead and create their mental picture, and then go to work
materializing that picture in all its details, filling in here, adding a
little there, altering this a bit and that bit, but steadily building,
steadily building.

Robert Collier, American motivational author, ( 1885-1950)

Now that Excel is open you are confronted with a dazzling array of
buttons, switches and other artifacts.

For now let’s explore the big picture by looking at how the Excel window
can be sized and moved. The details will come later.

1 Understand the Maximize, Minimize and Restore Down
buttons
At the top right corner of the Excel window you'll see three
buttons.
Maximize, Minimize and Close buttons
,E;a\ ™| & )= Bookl - Microsoft Excel |_ = X
—Q/ Home Insert Page Layout Formulas Data Review View @ - 2 x
=) X |||calipn LR [ = | =¢  General - Al g=msen - || X - A &
Pe By |||B r U -||A & - |98 % e ST F* Delete - || 8]~ ;}ZL i}&
T |[E[S A B %8 5% gz B Fomat - || 2+ Fitter~ select~
Clipboard & Font T} Alignment ) Number & Cells Editing
| AL ~ G £ ]
A B G D E F G H I 1 %
1
2

The buttons that you see will depend upon how the Excel window
was left last time the application closed down. Normally the Excel
screen is Maximized to fill the screeen and you'll see:

Restore Down
Minimize | Close

But if you had reduced the size of the Excel window so that it
didn’t fill the screen you'll see this instead:

Maximize

(Ijlose

Minimize

Try clicking the Maximize, Minimize and Restore Down buttons but
be careful to click the group of three buttons at the very top of the
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Other ways to close
down Excel

There are three expert ways of
closing Excel that will save a
second or two of your time.

1. Double click the Office
button at the top left of
your screen.

2. Press the <Ctrl>+<W> keys
on your keyboard. We'll be
learning more about
keyboard shortcuts later in
this session.

3. Press the <Alt>+<F4> keys
on your keyboard.

window and not the similar group beneath (we’ll be visiting those
in the next lesson).

B Maximize makes the Excel window completely fill the screen.
B Minimize reduces Excel to a button on the bottom task bar.

e ——

Click this button again to restore the window to its previous size.

B Restore Down makes the Excel window smaller allowing you to
re-size the window.

Re-size the window

After clicking the Restore down button you are able to re-size the
window. Hover over either the side of the window, or a corner of
the window, with your mouse cursor. The cursor shape will
change to a double-headed arrow.

When you see either cursor shape, hold down the left mouse
button and move the mouse (this is called click and drag) to re-size
the window.

Clicking and dragging a corner allows you to change both the
height and width of the window.

Clicking an edge allows you to change only one dimension.
Move the window.

Click and drag the Title Bar (the bar at the very top of the window)
to move the Excel Application window around the screen.

Close Excel

There are two common ways to close down Excel and three lesser
used methods (see sidebar). Most people will use one of the
following methods:

Click on the Close button * at the top right of the Excel application
window.

OR

Click on the Office button ' at the top left of the screen and then
click on the Exit Excel button at the bottom right of the dialog.

© 2008 The Smart Method Ltd
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Lesson 1-3: Understand the
Application and Workbook

windows

Excel can be thought of as a frame (the Application window) containing
one or more Workbook windows. Most of the time you will work with one
Application window containing one Workbook window.

Workbook window

Applicati(in window

Workbook Close, Minimize
and Restore Down buttons

Application Close, Minimize
and Restore Down buttons
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The screen grab above shows the normal way of working. The Workbook
window is maximized within the Application window.

If the Workbook (that’s the lower group of three buttons) Restore Down
button is clicked the workbook window floats within the frame provided

by the Application window.

Floating (restored)
Workbook window

Applicati(in window

Workbook Close, Minimize
and Restore Down buttons

Application Close, Minimize
and Restore Down buttons
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1 Close Excel down and re-start it again.
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note

What's the point of
having a floating
worksheet window?

At this stage in your journey of
discovery, none at all.

You need to know how to
maximize, minimize and
restore down the workbook
window because you might do
it by accident and need to fix
things up again.

In Lesson 2-2: Create a new
workbook and view two workbooks
at the same time, you’ll see how
Excel is able to display more
than one Workbook window
within the Application
window. This allows you to
view two worksheets at the
same time.

2 Click the Workbook’s Restore Down button (that’
the lower group of three buttons). !

The workbook floats within the Application window:
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Notice that the workbook’s Maximize, Minimize and Restore Down
buttons are now on the top right corner of the floating window.

3 Click the Workbook’s Maximize button.

The workbook completely fills the Application window:
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4 Understand the two close buttons.

You've probably noticed that there are two close buttons on screen.
One for the Application window, and one for the Workbook

window. How these buttons work is quite quirky.

Application close button

B Closes both the application and workbook windows when
only one workbook is open, or no workbooks are open.

B Closes only the active workbook (that’s the one that is
currently on display), when more than one workbook is open.

Workbook close button

B (Closes the workbook but always leave the application window

open.

© 2008 The Smart Method Ltd
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Important

Organizing your
sample files folder!

When you complete a lesson
that involves a sample file that
is changed, you will be
instructed to save the file with a
postfix.

By the time you’ve completed
the course you’ll have sample
files such as:

Sales

Sales-1
Sales-2
Sales-3 ... etc

The first file is a sample file that
you downloaded, and the
others (with the number
postfix) are interim versions as
you complete each lesson.

The sample file set includes the
sample file and all interim
versions.

The interim versions are
provided for two reasons:

1. If your work-in-progress
becomes unusable (for
example after a system
crash) you can continue
without starting at the
beginning again.

2. If alesson doesn’t seem to
give the results described,
you can load the example
to give some clues about
what has gone wrong.

It is a good idea to place the
sample files in a different folder
to your saved work. If you
don’t do this you'll be over-
writing the sample interim files
(such as Sales-1, Sales-2 etc)
with your own finished work.

| The Wealth of Nations

Lesson 1-4: Open and navigate
a workbook

Excel uses the analogy of a book that has many pages. In Excel
terminology we use the term: Workbook for the book and Worksheet for
each of the pages. We'll be learning more about worksheets later in this
session in Lesson 1-7: View, add, rename, delete and navigate worksheet tabs.

1 Download the sample files (if you haven't already done so).
1. Open your web browser and type in the URL:
www .learnmicrosoftexcel.com
2. Click the download link on the top left of the home page.
Learn Excel 2007 With The Smart Mef
RIS
ogn Excel 2007 in One Day with
If you have purchased my book click here for sample support files
3. Download the sample files.
2 Open the sample workbook: The Wealth of Nations.
Open Excel and then click on the Office button Y at the top left
of the screen.
Select Open from the drop down menu. Navigate to the folder
containing the sample files and double click The Wealth of Nations
to open the sample workbook.
If you prefer to use the keyboard, another way to open a workbook
is to hold down the <Ctrl> key and then press the <O> key.
3  Go to Cell ZZ3 using the Name box.
Name Box Active Cell ~ Formula Bar
I_/"_;J'\_I B H 5 The Wealth Of Nations - Microsoft Excel o = X
—Ey Hgme Insert Page ayout Formulas Data Review View 'Q) - 7 X
== ¥\l |calibri -l = =5 ||General - Alllsl == A7~
P't Zal||B Z U ~||A 4] == | |E93- % o o e R %
wdEoAT ||[EER] WS sl e PR
Clipboard Font U Alignment {F] Mumber Editing
| B3 - e | Luxembourg
A B & D E
1 |button Country GDP - per capita (PPP) Date of Information L
A 1 Qatar $ 80,900 2007 est.
3 2|Luxembourg |4 80,500 2007 est.
4 3 Bermuda $ 69,900 2004 est.

Excel uses the letter of the column and the number of the row to
identify cells. This is called the cell address. In the above example
the cell address of the active cell is B3.
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Excel 2007 is big!

"Space is big - really big - you
just won't believe how vastly,
hugely mind-bogglingly big it
is. You may think it's a long
way down the road to the
chemist, but that's just peanuts
to space”.

Douglas Adams, The
Hitchhikers’ Guide to the
Galaxy

A compelling reason to
upgrade from Excel 2003 to the
new 2007 version is the sheer
size of worksheets that can now
be manipulated.

Excel versions 97-2003 were
limited to 65,536 rows and 256
columns.

Many of my clients have
needed to overcome the “65,000
row problem” in earlier Excel
versions. Until now that meant
moving to Access (Microsoft’s
database management
application).

Excel 2007 worksheets can have
up to 1,048,576 rows and 16,585
columns.

Put into more understandable
terms.

¢ You could create a single
worksheet with the name of
every human being on the
planet and you wouldn’t run
out of cells (in fact, you
wouldn’t have even used half
of your worksheet).

e If you filled every cell and
printed out the worksheet it
would be 3.25 miles (5.24
kilometres) long and 320
yards (293 Metres) wide —
that’s a lot of paper.

Believe it or not, some of my
clients aren’t even happy with
this and are now running into
the “million row problem”!

o1

In Excel 2007 there are a little over a million rows and a little over
sixteen thousand columns. You may wonder how it is possible to
name all of these columns with only 26 letters in the alphabet.

When Excel runs out of letters it starts using two: X,Y,Z and then
AA, AB, AC etc. But even two letters is not enough. When Excel
reaches column ZZ it starts using three letters: ZX, ZY, ZZ and
then AAA, AAB, AAC etc.

The currently selected cell is called the Active Cell and has a black
line around it. The Active Cell’s address is always displayed in the
Name Box and its contents are displayed in the Formula Bar.

We can also use the Name Box to move to a specific cell.

To see this in action, type ZZ3 into the Name Box and then press the
<Enter> key. You are teleported to cell ZZ3:

| zz3 - |
§ zs zr zu zv Zw 2x zY zz

1

SN S

Return to Cell Al by pressing <CtrI>+<Home>.

Go to the end of the worksheet by pressing <Ctrl>+<End>.
Use the Scroll Bars.

There are two scroll bars for Excel’s workbook window.

The vertical scroll bar runs from top to bottom of the worksheet
window and allows you to quickly move up and down the
worksheet.

The horizontal scroll bar is at the bottom right hand side of the
workbook window and allows you to move to the left and right in
wide worksheets.

Here’s how the scroll bars work:

Click here to scroll one

pw View @ - 7 x
A [ =-40-  screen up or down
Styles || Cells j' :ﬁ' .
- Click here to scroll
—— one cell up or down.
D E 3
2007 est.
2007 est. Click and drag this
2 = button to quickly move
Sl |- - up and down the worksheet.

1 If you need more speed hold
2007 est: down the <Shift> key as you
2005 est.

2007 est. E' drag'

1
m@ 0 @.:E
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note

You can also use the <Ctrl>+<S>
keyboard shortcut to save your
work.

| The Wealth of Nations |

Lesson 1-5: Save a workbook

1

3

Save the workbook

When you are editing a workbook, the changes you make are only
held in the computer’s memory. If there is a power cut or your
computer crashes you will lose any work that has been done since
the last save.

For this reason you should get into the habit of regularly saving
your work.

Even though we haven’t changed this worksheet, let’s save it now
by clicking the Save button on the Quick Access Toolbar at the top
left of the screen.

Quick Access Toolbar

= |
@) =9
-

Save Button

Save the workbook with a different name.

Click the Office button and then hover over the Save As item in the
drop-down dialog.

You can see that it is possible to save your file in many different
formats.

.,,—-.\. H “ - = The Wealth Of Mation
.@r i

Save a copy of the document

Excel Workbook
il | Save the workbook in the default file
format.

=
I

ﬁ' Excel Macro-Enabled Workbook

11 save the workbook in the ¥ML-based and

Save ¥ !
macro-enabled file format.

IIT Excel Binary Workbook
Save As ¥ |mosn| Save the workbook in a binary file format
optimized for fast loading and saving.

ET

| Excel 97-2003 Workbook

| Save a copy of the workbook that is fully
compatible with Excel 97-2003.

é Find add-ins for other file formats
L2 —4 Other Formats

i Open the Save As dialog box to select from
all possible file types.

. _Publish »

Understand file formats.

Excel Workbook (the Open XML format)

Until very recently every program stored its information on the
hard disk in a completely different way. These incompatible
formats are called binary formats. This made it very difficult to
write applications that could be used together.

All of this has changed with the new file format: Office Open XML.
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How users of earlier
office versions can
read your OpenXML
files

Microsoft has a free download:
The Microsoft Office
Compatibility Pack.

If users of Excel XP (2002) or
2003 install this they will be
able to read and save Word,
Excel and PowerPoint 2007 files
in the new OpenXML format.

If the user has Office 97 or
Office 2000 they are out of luck.
You'll have to save your files in
the old 97-2003 format if you
need to share them.

The Smart Method still runs
many Excel 2000 courses
(especially for clients in the
banking and finance sector).
These users have no solution to
read an Open XML workbook
other than to upgrade.

Of course, as the years pass this
will become less of an issue.

File name: The Wealth of Mations Copy

Save as type: | Excel Workbook

Microsoft have published exactly how this format works and given
it away free to the world’s developer community. This allows
other programs to easily work with Excel workbook files. For
example, Apple’s iPhone already supports Office Open XML Email
attachments.

Unfortunately the future has to co-exist with the past and there are
a lot of people in the world using the older versions of Office (97,
2000, 2002 and 2003). If you save your files in the new Open XML
format only people running Office 2007 will be able to read them
(but see the sidebar for a potential solution to this problem).

Excel Macro Enabled Workbook

The Excel Macro Enabled Workbook is simply a workbook that has
program code (called Macro code) embedded within it. Macros are

beyond the scope of this book but are covered in our Excel Expert
Skills book

Macro programming (also called VBA programming) is a vast
subject of its own and is not useful to the vast majority of Excel
users. The Smart Method run comprehensive Excel VBA courses
but they are usually only taken by scientists and engineers who
need to add very advanced functionality to Excel.

Earlier versions of Excel could potentially allow a workbook to
infect your machine with a macro virus because all Excel files were
capable of carrying macros. By separating the formats it is easier to
avoid opening potentially infected files.

Excel 97-2003 Workbook

This is the old binary format that allows users with earlier versions
of Excel to read your workbooks. Some features won’'t work in
earlier versions and if you've used those in your workbook Excel
will display a warning and tell you which features will be lost.

Excel Binary Workbook

An oddity in Excel 2007 is a new binary format: Excel Binary
Workbook. This is a binary alternative to Open XML but it can’t be
read by earlier versions of Excel. The advantage of this format is
that it loads and saves more quickly than Open XML.

Save the workbook with a different name.

1. Click on the Excel Workbook icon.

2. Type: The Wealth of Nations Copy into the File name text box.
3. Click the Save button.

Notice that the name of the workbook in the title bar (at the
top of the window) has now changed indicating that you are
now viewing the new workbook that you have just saved.

© 2008 The Smart Method Ltd
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tip
Increasing the
number of items in

the recent documents
list.

Excel remembers the seventeen
most recently opened
documents.

As you open more documents
the seventeenth oldest is
removed from the Recent
Documents list unless you pin
it.

If you’d like to increase Excel’s
memory up to a maximum of
fifty items here’s how it’s done:

1.  Click the Office button at
the top left of the screen.

2. Click the Excel Options
button at the bottom right
of the dialog.

3. Choose Advanced from the
left hand pane.

4.  Scroll down the right-hand
list until you find the
Display category. You'll
see Show this number of
Recent Documents: 17.

5. Change the number to the
number of recent
documents you’d prefer
Excel to remember (up to a
maximum of fifty).

Lesson 1-6: Pin a document
and understand file
organization

1 Close down and restart Excel.
2 Pin a workbook to the Recent Documents list.
1. Click the Office Button at the top left of the screen.

On the right hand side of the dialog is a list of all recently
opened documents beginning with the most recent (probably
the Wealth of Nations worksheet opened during the last lesson).

Note that there is a pin icon = next to each workbook name.

When you hover over the pin a tooltip is displayed saying: Pin
this document to the Recent Documents list.

IG_ i AlAD = Bookl - Micr
Y
Recent Documents
)
1 The Wealth Of Nations 1=l
] 2 BM |
Open J Pin this document to the Recent Documents list
3 200oowes -
5 4 Menu Week Commencing 28th June 2005 =
H ave
= E

This can be a great time saver as it enables any workbook that
you use a lot to always be in the Recent Documents list. You
won’t have to waste time looking for it on the hard drive.

2. Click the pin icon. The icon changes from unpinned = to

pinned.

Recent Documents

1 The Wealth Of Mations L
2 BMI2007 1=l
3 2008 Bikes 1=l

3. Click on The Wealth of Nations to open the workbook.
3 Understand file organization.

By default Excel saves all workbooks into your documents folder
along with other Office documents (such as Word and PowerPoint
files). This clearly is going to cause problems when you have a few
hundred files.

Better to organize yourself from the start by setting up an orderly
filing system.

I create a folder called Excel beneath the Documents folder. In this
folder I create subfolders to store my work. You can see a screen
grab of my Excel folder in the sidebar (of course, your needs will
be different to mine).
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Folders
4 | Excel

. Accommodation

) Accounts

. Bank Receonciliations
. Bank Statements

, Book Publishing

. Budgets

. Business and employment
. Cars and motorcycles
. Credit Cards

. Currency

. Diet

. Inflation Figures RPI RPIX
. Insurance

. Miscellaneous

. Personal

. Recipes

| Stationery Orders

| Taxes

. Training

, Travel

. Tutorials

. VBA Examples

. Web Sites

Set the default file location.

If you take my advice and create an Excel folder you will waste a
mouse click every time you open a file because Excel will take you
to the documents folder by default.

Here’s how to reset the default file location to your new Excel
folder:
1. Click the Office button = at the top left of the screen.

2. Click the Excel Options button at the bottom right of the
dialog.

3. Choose the Save category from the left hand side of the dialog.
4. Change the default file location.

You have to actually type in the default file location. Microsoft
seems to have forgotten to add a browse button!

Excel Options

Popular :

Customize how workbooks are saved.
Formulas
Proofing 5ave workbooks
Save ] Save files in this format: Excel Workbook
Advanced Save AutoRecover information every |10 =
Customize AutoRecover file location:  |Ch\Users\MSmart\AppData

Default file location: Chllsers'\MSmarth\Excel

Add-Ins
Trust Center AutoRecover exceptions for: [I:| Bookl
Resources [ Disable AutoRecover for this workbook only

When you click Office>Open in future you'll automatically be
taken to your Excel folder ready to choose a category.

During the remainder of the book I'll explain the above sequence
of choices like this:

Click Office->Excel Option—>Save and then change the default file
location.

This will save a lot of time and forests!

© 2008 The Smart Method Ltd
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Lesson 1-7: View, add, rename,
delete and navigate worksheet
tabs

When you save an Excel file onto your hard disk, you are saving a single
workbook containing one or more worksheets.

You can add as many Worksheets as you like to a Workbook.

There are two types of worksheet. Regular worksheets contain cells (just
like the one you're looking at now). Chart sheets, as you would expect,
each contain a single chart (we’ll be exploring charts in depth in: Session
Five: Charts and Graphics).

When you save an Excel file onto your hard disk you are saving a single
workbook containing one or more worksheets.

1 Open The Wealth of Nations from your sample files folder (if
it isn’t already open).

2  Move between worksheets.

Look at the tabs on the bottom left corner of your screen. Notice
that this sample workbook contains three worksheets: GDP, Life
Expectancy and Mobile Phones. Click on each tab in turn to view
the different worksheets.

GDP . Life Expectancy | Mobile Phones .~ #J

3 Add a new worksheet.

1. Click the Insert Worksheet tab (the tiny tab next to Mobile
Phones). A new tab appears named Sheet1.

2. Double-click the Sheet1 tab.
3. Type the word Population followed by the <Enter> key.
GDP - Life Expectancy Mobile Phones | Population %
4 Move a worksheet's tab.
1. Click on the Population tab (you may have to do this twice).

2. Drag to the left. As you drag you'll notice an icon of a page
and a black arrow telling you where the tab will be placed.

3. Release the mouse button to move the tab to the location of
your choice.

27 J
M 4+ M | GDP . Life Expectancy Mobile Phones | Population %2

5 Understand the tab scroll buttons

Because this workbook only has four tabs, there’s no need to use
the tab scroll buttons (in fact, they won’t work at all when all tabs
are visible).

The Wealth of Nations |
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S

10

First
Previous
Next

]rast

M 4 » M

When there are more tabs than will fit on the screen the tab scroll
buttons are used to move between tabs.

Move between worksheets using the keyboard.

You can move between worksheets using only the keyboard by
pressing the <Ctrl>+<PgUp> and <Ctrl>+<PgDn> keyboard
shortcuts to cycle through all of the tabs in your workbook.

Change tab colors.

The colored tab feature was only added in Excel 2003 and most
users have yet to discover that they can color code their tabs.
Others will be very impressed if you color code yours!

1. Right-click on any of the tabs and choose Tab Color from the
shortcut menu.

2. Choose any color.
3. Repeat for the other tabs on the worksheet.
Delete a worksheet.

Right click on the Population tab and select Delete from the
shortcut menu.

Delete several worksheets at the same time.
1. Hold down the <Ctrl> key.

2. Click each tab you want to delete in turn. Don’t select them all
as it isn’t possible to delete every worksheet in a workbook.

3. Right click any of the selected tabs and select Delete from the
shortcut menu.

Don’t worry about the missing tabs. We're going to close the
workbook without saving it so you won’t overwrite the original
workbook.

Close the workbook without saving it.
1. Click Office>Close.

A dialog is displayed:
Micreseft Office Excel [=3]
l ., Doyouwant tosave the changes you made to ‘The Wealth Of Mations.xdsx'?
[ Yes ] | Mo | | Cancel |

2. Click No so that you don’t over-write the workbook.

Because you haven’t saved the workbook it will remain in its
original state when you next open it.

© 2008 The Smart Method Ltd
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note

Older versions of Excel hid all
of their best features
underneath an arcane system of
menu navigation. Many users
didn’t know that half of the
features were there at all.

Because only the standard and
formatting toolbars were
visible on screen, users didn’t
explore the menu options and,
instead, used only a tiny subset
of Excel’s features.

The Ribbon makes Excel seem
overwhelming because all of
those features are right in your
face.

Hardly anybody in the
workplace today understands
every one of Excel’s features.
You'll be doing productive
work with Excel by session two
of this book while using a tiny
subset of the full feature set. By
the end of the book you'll be
thoroughly competent working
with Excel.

note

The Ribbon shows
more if you have a
wide screen

When I work with Excel I use a
22 inch widescreen monitor
running at 1,680%1,050 pixels.

Excel uses the extra screen
space to display extended
descriptions of each feature on
the Ribbon.

For example, the Styles pane on
the Home Ribbon expands to
show buttons for nine common
cell styles allowing them to be
applied with a single click
rather than two clicks.

Home Insert Page Layout

i EEDD gkl |

Picture Clip Shapes Smart&rt | Column Line Pie Bar
Art

FivotTable Table

Tables Nustrations

Formulas Data Review View

Lesson 1-8: Use the Ribbon

Look what they've done to my song, Ma
Look what they've done to my song

Well it's the only thing I could do half right
And it's turning out all wrong, Ma

Look what they've done to my song

Song lyric by Melanie (M. Safka)

The Ribbon causes huge frustration for seasoned Excel 97 to 2003 users as
everything seems to be in the “wrong place”. “Look what they’ve done to
Excel” they cry. But it’s a better, and an entirely new, way of working.

The sheer breadth of Excel features can seem overwhelming. This book
will gently introduce all of the most important features, one at a time. By
the end of the book you'll be really comfortable and productive with the
Ribbon.

1 Start Excel and open a new workbook.
1. Click Office>New.
The New Workbook dialog appears.

New Workbook

Templates o seif Blank Workbook

Elank and recent

Installed Templates Blank and rec...

My templates...
Mew from existing...

Microsoft Office Online

m

m

Blank Workbook
Featured

Agendas
Budgets
Calendars

Expense reports

2. Double-click the Blank Workbook icon to create a new blank
workbook.

2  Use Ribbon tabs.

Each Ribbon tab has its own toolkit available to you. By far the
most important tab is the Home tab which has buttons for all of the
most common and useful features.

Click each tab in turn and view the buttons. The screen grab below
has the Insert Tab selected. Don’t worry if the buttons seem cryptic
at the moment. Most of them will make complete sense by the end
of this book.

If you later go on to complete the Expert course too, Excel will
have no mysteries left at all!

't“) S, ™ b 4
A = 3 VES
Area Scatter Other Hyperlink Text Header WordArt Signature Object Symbol

T i . T i Charts ~ Box & Footer T Line -
Charts {F] Links Text

38

www.LearnMicrosoftExcel.com



Session One: Basic Skills

note

contextual tabs

If you are doing something
special, such as previewing a
worksheet, Excel doesn’t want
to bother you with a lot of
commands that are irrelevant.

For this reason you'll often see
a cut-down version of the
Ribbon, listing only the
commands that are available at
that time. For example, when
you change to print preview
view (we cover that later in
Lesson 1-10: Customize the Quick
Access Toolbar and preview the
printout), you'll see a cut-down
Ribbon with only one tab
containing all of the things you
are able to do when previewing
a printout.

Sometimes Excel will show you
even more tabs. For example,
when you select a picture, a
Picture Tools tab group will
magically appear containing a
Format tab. This enables you to
enhance the picture.

note

Other ways to show
and hide the Ribbon

1. Press <Ctrl>+<F1>.

2. Right-click anywhere on
the Ribbon and choose
minimize the Ribbon from
the shortcut menu.

You can do any of the above a
second time to bring the Ribbon
back.

If you close Excel with the
Ribbon hidden it will still be
hidden when you re-open it.

Customize Quick

Access Toolbar

Button |

NI L AXCESL
&3/"

— Home Insert

Type the word Test into any blank cell and then press the
<Enter> key on the keyboard once.

Notice how the Active Cell moves to the cell beneath.

A B

Test

Make the cell with the word Test into the active cell.

Click once on the word Test or use the arrow keys on the keyboard
to navigate back to the cell. Be very careful not to double-click
otherwise Excel will think that you want to edit the cell.

A B
1

2 Test I

Click the Home tab on the Ribbon and focus upon the Font
panel (it's the second panel from the left). Try clicking each
of the buttons and you will see the word Test change to
reflect your choices.

This drop-down allows you to
change the font to something
different to the default Calibri.

Click here once to make the :|
text Bold, Italic or Underlined
(or all three). Click again to
restore it to Normal.

This drop-down arrow allows — length of the bottom of the
you to add a double underline.

This drop-down allows you to
change the size of the font
(measured in points).

e I e These buttons allow you to
B I U-~[&-d- A~

= change the cell’s background
o and text colour.

Clicking here puts a single
underline along the entire

cell. Try the drop-down arrow
too for more border options.

6

Minimize the Ribbon.

To minimize the Ribbon in order to save screen space, click the
Customize the Quick Access Toolbar button (see sidebar) and choose
Minimize the Ribbon from the drop-down menu. Notice how the
Ribbon now takes up far less screen space.

An even quicker way of doing the same thing is to double-click
any of the tabs.

Double-click once more to bring the Ribbon back to full size.
Save your work with the name Ribbon Test and close Excel.

Click Office->Save As—>Excel Workbook, type in the file name
(Ribbon) and then click the Save button.

© 2008 The Smart Method Ltd
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Lesson 1-9: Understand
Ribbon components

The whole is more than the sum of its parts.
Aristotle, Greek critic, philosopher, physicist & zoologist
(384 BC - 322 BC)

The Ribbon is made up of several different artifacts.

g Normal button

Simply executes a command when clicked. The Bold button on the Home
tab is a good example.

- Menu or gallery button
+EE
] This type of button has a little down-arrow on it. It will display a Menu

Insert  or Gallery when clicked.

Split button

This is the hardest button to understand because these buttons look
almost the same as the menu or gallery button. When you hover the mouse
cursor over a split button, the icon and drop-down arrow highlight
seperately as different “buttons within a button”.

=
4

A good example is the underline button on the Home toolbar.

=
4

Clicking the icon part of a split button (the U) will perform the default
action of the button (in this case a single underline). Clicking the arrow
D Double Underline part of the button will display a menu of further choices (in this case the
— choice between a single and double underline).

=

Underline

Check box
Gridlines
A little square box that you can click to switch an option on or off.

V| View
In this example (from the Page Layout Ribbon) you are able to switch the

Print gridlines on and off for the screen display and/or the printout.

Command group

General " Similar actions are grouped into a cluster. For example, every component

relating to numbers is clustered into the Number group.
L .0 .00
G- ooy || %0 5%

Mumber F
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a3 | Insert Cells...

S | Insert Sheet Bows

Insert Sheet Columns

i
L_ﬂj Ingert Sheet

Dialog launcher

Dialog launchers appear on the bottom right-hand corner of command
groups. Dialogs offer more choice than it is possible for the Ribbon to
express graphically. Many of the dialog launchers will present a dialog
that is identical to the old dialogs from Excel 2003.

General =
q a .0 .00
"‘j__*g' Yo % ||T6a .0

Mumber I

Dialog launcher

Drop down list

I often shorten this to simply “Drop Down” in this book. A drop down is
a simple menu listing several choices.

If you see an ellipsis (...) after a drop down list item this means that a
dialog will be displayed after you click, offering further choices.

Drop down gallery

This is a little like a drop down list but has graphics to visually
demonstrate the effect of each choice.

Styles
Good, Bad and Neutral

MNormal Bad Good Neutral

Data and Model

|Cs culation ||| {| cxplonatory ... Linked Ce Note
Output Warning Text

Rich menu

The rich menu is Microsoft’s way of trying to coerce you into being brave
enough to use a feature that you might not have understood in previous
Excel versions. A sort of an “in your face” help system.

Freeze

Panes ~

Freeze Panes

Keep rows and columns visible while the rest of
the worksheet scrolls (based an current selection).
Freeze Top Row

Keep the top row visible while scrolling through
the rest of the worksheet,

Freeze First Column

Keep the first column visible while scrolling
through the rest of the worksheet,

O

© 2008 The Smart Method Ltd
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note

If you are used to an
earlier version of
Excel you might
wonder where all of
the toolbars have
gone?

In earlier versions of Excel it
was possible to create as many

of your own custom toolbars as

you wanted.

The new Ribbon based user
interface (Microsoft calls this
the Fluent Interface) means that
you don’t need to create
toolbars to the same extent in

Excel 2007, because every panel

on the Ribbon is, essentially, a
toolbar.

Customize Quick
Access Toolbar
Button |
E;ﬂ = @ - s
—E-:y Haome Insert

Customize Quick Access Toolbar

Mew

Open
v | Save

E-mail

Quick Print

Print Preview

Spelling
v | Undo
v | Redo

Sort Ascending
Sort Descending
More Commands...

Show Below the Ribbon

Minimize the Ribbon

The Wealth of Nations

Lesson 1-10: Customize the
Quick Access Toolbar and
preview the printout

In Excel 2007 you may have just one custom toolbar: the Quick Access
Toolbar. In this lesson we’ll add some useful buttons to the Quick Access
Toolbar to save a few clicks.

The Quick Access Toolbar is one of the keys to being really productive
with Excel 2007. This lesson will introduce you to the main features.

1 Open The Wealth of Nations from your sample folder, (if it
isn't already open).

2 Preview how the Life Expectancy worksheet will look when
printed.

1. Click the Life Expectancy tab at the bottom of the worksheet.
2. Click Office>Print->Print Preview:

™ I, = The Wealth Of Nation
‘E—%ﬁ
-
j Preview and print the document
HNew
|_b| Print
~u ‘-“I'gr‘] Select a printer, number of copies, and
Open other printing options before printing.
{2 Quick Print
| I Save [ Send the workbook directly to the default
- printer without making changes.
_“_1 s Print Preview
. Save As L ﬁ Preview and make changes to pages before
printing.
] : : s
,—H] Print b Print Preview [Ctrl=F2)

A preview of the how the page will print is displayed.

Notice that the Ribbon now displays a contextual menu
because there are only a few options open to you when
previewing.

3. Click the Next Page and Previous Page buttons to move through
the print preview.

4. Use the Zoom button to magnify the page for a clearer view.
5. Click the Close Print Preview button to return to the workbook.
3 Add a Print Preview button to the Quick Access Toolbar.

Print Preview is a very useful feature and you’ll probably use it a
lot. Every time you use it, however, it is going to take three clicks
of the mouse. Wouldn't it be better if you could show a print
preview with just one click?

1. Click the Customize Quick Access Toolbar button (see sidebar).

2. Click the Print Preview item in the drop-down list.
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note

Some amazing Excel
features cannot be
used at all without
customizing the
Quick Access
Toolbar!

One of my favourite features in
Excel 2007 is its ability to read
the workbook to me via its Text
to Voice facility.

When I have input lots of
numbers from a sheet of paper
and want to check them I get
Excel to read them to me as I
tick each off my list. This is
much faster and nicer than
continuously looking first at the
screen, then at the paper, for
each entry.

This feature is covered in depth
in the Expert Skills book in this
series.

You can’t use this feature at all
unless you add some custom
buttons to the Quick Access
Toolbar!

tip
The Quick Access Toolbar is

one of the keys to being really
productive with Excel 2007.

Always try to minimize the
number of mouse clicks needed
to do common tasks.

If you find yourself forever
changing tabs to use a button,
change two clicks into one by
adding the button to the Quick
Access Toolbar.

All of those extra clicks add up
to a lot of time over the weeks
and years.

A new button now appears on the Quick Access Toolbar. You
are now able to Print Preview your work with a single click of
the mouse.
E-E-n Llﬂ k!] o _::. -
—/I Home Insert P
Add a Font Color button to the Quick Access Toolbar.

The More Commands... option is available when you click the
Customize Quick Access Toolbar button. This enables you to add any
command in Excel to the toolbar. But there’s an easier way!

1. Click the Home tab on the Ribbon (if it isn’t already selected)

A
2. Right-click on the Font Color button in the Font Group.

A - i= =l X | .0 .00 L=

L\\_‘5 Add to Quick Access Toolbar

Customize Quick Access Toolbar...
Show Quick Access Toolbar Below the Ribbon
Minimize the Ribbon

3. Click Add to Quick Access Toolbar.
A Font Color button is added to the Quick Access Toolbar.

Do) D EH9--A])-

Remove a button from the Quick Access Toolbar.

1. Right-click on the Font Color button you've just added to the
Quick Access Toolbar.

2. Click Remove from Quick Access Toolbar on the shortcut menu.

Add separators to make heavily customized Quick Access
toolbars more readable.

1. When you add many items to the Quick Access toolbar it is a
good idea to use separators to split icons into logical groups.

2. Click the Customize Quick Access Toolbar button. E

3. Click More Commands... on the shortcut menu.

4. Click the LZ3%P3M30% Jitem at the top of the Commands list.

Add =

5. Click the Add>> button.

6. Use the up El and down IZI buttons to move the

separator to the required location.

Here’s a screen grab of my own Quick Access Toolbar:

Ca D-N I EHS R VIZive O-A-B% » WB|H-)s
2
- Home Insert Seperators “ formulas Data Review View Developer

© 2008 The Smart Method Ltd
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Important

Keyboard shortcuts
don’t work with the
numeric keypad

It’s a strange quirk of Excel that
you must use the number keys
along the top of your keyboard
when using keyboard shortcuts
that involve a number.

If you use the numeric keypad
on the right of your keyboard
they won’t work.

note

Keyboard shortcuts
are one of the secrets
of maximizing
productivity with
Excel

Many years ago I took my
mouse and stuck it to the back
of my monitor with sticky tape.

For a whole day I struggled to
work without it.

The first few hours weren’t
much fun but after that my
work became faster and faster.
It became a challenge to figure
out how to do things without
the mouse.

You will be far more
productive if you can get into
the same habit.

These days, there are some

things that you simply need the

mouse for, and some things
that are genuinely faster (or
easier) with the mouse. For
most common tasks, however,
there are keyboard shortcuts
and Excel 2007 has just made
things a lot easier with the new
Key Tips feature.

The Wealth of Nations |

Lesson 1-11: Use the Mini
Toolbar, Key Tips and
keyboard shortcuts

1

2

5

Open the Wealth of Nations sample worksheet (if it isn’t
already open).

Select cell B2 (Qatar) on the GDP worksheet.
1. Click on the GDP tab.
2. Click on cell B2 (Qatar).

Make sure that you only click once otherwise Excel will think
that you are trying to edit the cell.

A B C
GDP - per capita (PPP)
I$ 80,900

1 |button Country
2 1|Clatar

Make cell B2 (Qatar) bold, italicized and underlined.
1. Click Home->Font->Bold

2. Click Home->Font->Italic

3. Click Home—->Font->Underline

A B C
1 button Country GDP - per capita (PPP)

2 1|gnmr $ 80,900
Display Key Tips.

Hold down the <Alt> key on the keyboard.

Notice how Key Tips are now displayed on the Ribbon and the
Quick Access Toolbar:

alinl Inse Pag out Formulas
O;
J | Page Break Preview :
IjJ Custom Views ¥ Gridlines
Mormal| Page
Layout = Full Screen ge Bz
Waorkbook Views Show

Use the Key Tips to show a print preview using only the
keyboard.

The key tips reveal the key you need to press to simulate clicking
any of the Ribbon and Quick Access Toolbar icons.

Hold down the <Alt> key and press the relevant number to show a
print preview.

NB: Your toolbar, and the number you need to press, may look
different to the screen grab above. For example, the print preview
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note

If you don’t like the
Mini Toolbar you can
switch it off

Personally I really like the mini
toolbar and wouldn’t dream of
switching it off but if you are
used to an early version of
Excel and find that it annoys
you, here is how it’s done:

1. Click the Office button.

2.  Click the Excel Options
button at the bottom right
of the dialog.

3.  Click the Popular item in
the left-hand list.

4. Uncheck the Show Mini
Toolbar item.

5. Click the OK button.

note

The shortcut menu

If you right-click on a cell, a
shortcut menu is displayed.

The shortcut menu doesn’t
display everything that you can
do to a cell but Excel’s best
guesses at the most likely things
you might want to do.

Because Excel is guessing at the
actions you might want to take
in the context of what you are
doing, the shortcut menu is also
sometimes referred to as the
contextual menu.

button will not be on the Quick Access Toolbar unless you added it
during: Lesson 1-10: Customize the Quick Access Toolbar and preview
the printout.
Click the Close Print Preview button &4 to return to normal
Use the mouse to select the text Qatar in cell B2.
1. Double-click the cell containing the text.

You'll see the cursor flashing in the cell.

2. Position the mouse just after the word Qatar and hold down
the left mouse button.

3. Drag the mouse across the complete word until it is
highlighted like this:

oot

Observe the Mini Toolbar.

Hover the mouse cursor over the selected text and you should see
a “ghost” image of the Mini Toolbar just above the cell:

R =W J= | Uatar
1 Calibori L —

Bl A-A A

—— —-- - g4

octar

When you move the mouse cursor up and over the Mini Toolbar it
will light up.

Use the Mini Toolbar to restore the text to non-bold and non-
italic.

Click on the Bold and Italic buttons to remove the bold
and italic attributes from the text.

Qatar

Show a bigger Mini Toolbar with a right-click.

Right-click on Bermuda (Cell B4). Notice that, as well as the
shortcut menu (see sidebar) you now get an even better Mini
Toolbar with a few extra buttons.

Remove the underline from Qatar.
1. Click on Qatar again (cell B2).

2. Press the <Ctrl>+<U> keys on the keyboard to remove the
underline.

But how can you remember cryptic keyboard shortcuts like
<Ctrl>+<U>? Fortunatelf you don’t have to. Hover the mouse over

the underline button and you'll see the keyboard shortcut

listed in the tooltip.

© 2008 The Smart Method Ltd
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| The Wealth of Nations |

Lesson 1-12: Understand
Views

Views are different ways to look at your worksheet.
Excel 2007 has three views. They are:-

View Icon What it is used for

Normal This is the view you’'ve been using until now.
% It's the view most users use all of the time
when they are working with Excel.

Page break A page break is when the printer advances
preview onto a new sheet of paper.

-u We'll use this view in : Lesson 7-5: Insert, delete
and preview page breaks to make sure that the
page breaks in the right place.

Page layout This is a fantastic new view for Excel 2007. It
allows you to see (almost) exactly what the
D printout will look like.

Unlike running a Print Preview you are able
to edit cells just as you can in Normal view.

1 Open the Wealth of Nations sample worksheet (if it isn’t
already open).

|En NOE9-™ lei 5 The Wealth Of MNations - Microsoft Excel = =
L | ! =
- Home Insert Page Layout Farmulas Data Review View @ - = X
HI [ J J’_J: 3 | e ._\‘:J, New Window ] | 1] . = %
§ = Arrange All | E‘ =z
rmal| Page Show/Hide | Zoom 100% Zoomto . Y Save Switch Macros
Layout = - Selection || B Freeze Panes ~ (] | 414 Waorkspace Windows ~ -
‘Workbook Views Zoom Window Macros
D23 - e | 2007 est.
| a B _ c Lbe | E | F G
1 |button Country GDP - per capita (PPP) Date of Information =
2 1 Qatar 480,900 2007 est. !
3 2 Luxembourg $ 80,500 2007 est.
4 3 Bermuda $ 69,900 2004 est.
5 4 Jersey 457,000 2005 est.
6 | 5 Malta 553,400 2007 est.
7 6 Norway $53,000 2007 est.

4 4 » M| GDP - Life Expectancy . Population .~ Mobile Phones -
Ready

View buttons

2 Click on the GDP tab and then click on the page layout view
button at the bottom of the screen.

The worksheet is displayed in page layout view. It is a little like Print
Preview view as you are able to see (almost) exactly what will be
printed. Headers, footers and margins are all shown.

Unlike Print Preview view you are able to edit the worksheet.
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You may wonder why we don’t use page layout view as the
default when editing worksheets. While some users may prefer to
do this, most will want to see the maximum amount of data
possible on screen and so will prefer the Normal view.

||:!g QHE92-© u'x|é| = The Wealth Of

Home Insert Page Layout Formulas Data Revigf

‘ D J.I Page Break Preview l";

15 Custom Views
Mormal| Page E Show/Hide | Zoom 100% Zoomto
Layout |5 Full Screen b Selection

Workbook Views Zoaom

Ml D23 - @ £ | 2007 est.

'|'L|'|'_'|'i|'|'2|'|'5|'

T e a3

18 | 17 Andorra

19 18 Iceland

20 19 Metherlands

20 British Virgin Islands
21 Austria

22 Canada

23 Gibraltar

24 Denmark

25 United Arab Emirates

=

"

4+ M| GDP - Life Expectancy . Populstion -~ Mobile Phones - ¢
Ready @ Page:1 of10 |

[ 17|
3 Click the page break preview button.

The worksheet is displayed in page break preview view (you may
also see a help dialog first).

This view shows each page with a watermark to indicate which
sheet of paper it will be printed on:

L J
A E C u] E
2 21 Austria £ 38,400 2007 est,
3 22 Canada £ 38,400 2007 et
o4 23 Gibraltar £ 38,200 2008 est,
25 24 Denmark ™ L FE74004 2007 est.
26 26 United Arab Emirates” = [ | gad200 | 2007 est.
7 26 Sweden = -1 2007 est.
28 27 Australia 4 36,300 2007 e=t,
29 28 Belgium 4 35,300 2007 est,
o P e o e

It also shows the break between each page as a dotted line:

A E [ [u] E
47 45 Mew Zealand F 26,400 2007 st
48 47 lzrael F 25,800 2007 est.
44 42 Bahamas, The 4 26,000 2007 est.
1] 43 Falkland Izlandsz [Islas Malvinas] § 26,000 2002 est.
51 | _50 Lischtenstein _ _ __ _ _ $25000 _ _ _ 1999est
52 A1 Korea, South 24,800 2007 est.
53 52 Czech Republic 24,200 2007 est.
A4 53 Oman F 24,000 2007 est.
e et moLin PR ACAT -

It is possible to click and drag the dotted line to change the place
where the page breaks. This will be covered in depth in: Lesson 7-6:
Adjust page breaks using Page Break Preview.

© 2008 The Smart Method Ltd
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Lesson 1-13: Use full screen
view

1 Open the Wealth of Nations from your sample files folder (if it
isn't already open) and click the Life Expectancy tab.

I/Es': = R s The Wealth Of Nations - Microsoft Excel i

- - Home  Insert Page Layout  Formulas Data Review | View Developer '@ - =2 X
ﬂ Research \j oy R | _’2_:35 Protect Sheet @ Protect and Share Workbook
QraThesaurus et P 3_1‘],Protecl:\v\l'orlt:bool(v @Allow Users to Edit Ranges

Spelling ., Mew Lt 3
dg Translate Comment —d QShareWorkbook _L}Track Changes ~

Proofing Comments Changes
I Fl4 - @ %] ¥

1 |Rank Country Life expectancy at birth Date of Information

2 1 Andorra 83.53 2008 est.

3 2 Macau 82.35 2008 est.

4| 3 Japan 82.07 2008 est.

5 4 Singapore 81.89 2008 est.

6 5 5an Marino 81.88 2008 est.

7y 6 Hong Kong 81.77 2008 est.

8 7 Canada 81.16 2008 est.

) & France 80.87 2008 est.

10| 9 Sweden 80.74 2008 est.

11 10 Switzerland 80.74 2008 est.

4 4 » M| GDP | Life Expectancy < Population -~

Ready S

Notice that the Ribbon, formula bar and status bar are all taking up
space that could be used to display information. In the example
above only the first ten rows are visible.

1 Double-click on any of the Ribbon tabs to hide the Ribbon.

I/Es': = R s The Wealth Of Nations - Microsoft Excel T
- - Home  Insert Page Layout  Formulas Data Review  View Developer '@ - =2 X
I F14 N £ |
A B C D
1 Rank Country Life expectancy at birth Date of Information
K 1 Andorra 83.53 2008 est.
3 2 Macau 82.35 2008 est.
4 3 Japan 82.07 2008 est.
3| 4 Singapore 81.89 2008 est.
6 5 San Marino 81.88 2008 est.
i 6 Hong Kong 81.77 2008 est.
8 7 Canada 81.16 2008 est.
9| & France 80.87 2008 est.
10 9 Sweden 80.74 2008 est.
11| 10 Switzerland 80.74 2008 est.
12 11 Australia 80.73 2008 est.
13| 12 Guernsey 80.65 2008 est.
14| 13 Israel 80.61 2008 est.
15| 14 Iceland 80.55 2008 est.
16| 15 Anguilla . ol ; 80.53 2008 est.
4 4 » M| GDP | Life Expectancy .~ Population .~ Mobile || [4I]
Ready | P

With the Ribbon hidden things are a little better. Fifteen rows are
now visible. Perhaps you want to view even more. This is what
Full Screen View is for.

2 Click View>Workbook Views-=>Full Screen.

The Wealth of Nations
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1
2
3
4
5
6
7
8
5
10

14
15
16
17

19
20
21

23
24
25
26

28
23
30
31

33

x| The Wealth OF Mation

A B

|Rank Country

1|
12 |
13 |

18|

2|

27 |

32|

1 Andorra

2 Macau

3 Japan

4 Singapore

5 San Marino

6 Hong Kong

7 Canada

8 France

9 Sweden
10 Switzerland
11 Australia

12 Guernsay
13 Israel
14 lceland
15 Anguilla
16 Cayman Islands
17 New Zealand
18 Raly
19 Gibraltar
20 Monaco
21 Liechtenstein
22 Spain
23 Norway
24 Jersey
25 Greece
26 Austria
27 Virgin Islands
28 Malta
29 Faroe Islands
30 MNetherlands
31 Luxembourg
32 Montserrat
33 Germany

34
H 4+ M GDP Ufe%tang POEuhtiun Mobile Phones - Nwg %2

x = Microsoft Excel

C D E F G H L Ui K
Life expectancy at birth Date of Information

83.53 2008 est.
82.35 2008 est.
82.07 2008 est.
81.89 2008 est.
81.88 2008 est.
81.77 2008 est.
81.16 2008 est.
80.87 2008 est.
50.74 2008 est.
80.74 2008 est.
80.73 2008 est.
80.65 2008 est.
80.61 2008 est.
80.55 2008 est.
80.53 2008 est.
80.32 2008 est.
80.24 2008 est.
80.07 2008 est.
80.06 2008 est.
79.96 2008 est.
79.95 2008 est.
79.92 2008 est.
79.81 2008 est.
79.65 2008 est.
79.52 2008 est.
79.36 2008 est.
79.34 2008 est.

79.3 2008 est.
79.29 2008 est.
79.25 2008 est.
79.18 2008 est.
79.15 2008 est.

79,1 2008 est.

Note that the Quick Access Toolbar, the Ribbon, the formula bar
and the status bar have all vanished. On the above example shown
at 1,024*768 screen resolution 34 rows are visible.

On my own 22 inch monitor running at 1,680%*1,050 pixels in
portrait mode I can view 81 rows of information on one screen.

3 Switch back to normal view.
To return to normal view either:
Press the <Esc> key on the keyboard.
OR
Right click in any cell and then click Close Full Screen.

© 2008 The Smart Method Ltd
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Tip
The Keep On Top
button

When this button is pinned in

like this: IE' the help window
will stay on top of all open
Office windows.

When the button is unpinned

like this the window will

be hidden if you move other
Office windows on top of the
help window.

Note that this is only the case
with Microsoft Office windows
and not with windows from
other applications.

Lesson 1-14: Use the help

system

|@

The help dialog is displayed

1 Click the Help button

at the top right of your screen.

If your screen doesn’t look like this, click the show/hide table of

contents button.

vFiIe conversion and compatibility

Type a question here to search the help
system for answers.
Keep on top
button
Show/hide Choose which content
table of to view and search
contents
Find help by category
€ Excq Help | - ] x
G X @ @ AMD e -
ribbon + B Search ~
Table of Contents E
&y What's new =
.\.//Getﬁng help =
.\.,/Installing = S
.\.//Acﬁvaﬁng Excel T EREITED N
.\.//Cushnmizing | & What's new Getting help
lv.ﬁccessibility Instaling Activating Excel

2 Type how do | save a file into the search box followed by

the <Enter> key.

The help system provides many potential answers to the question:

&) Excel Help
CIOECICE N - E K

= = x

i

How do I save a file

+ B Search -

Table of Contents
.\{.r/whafs new
.\V/Getﬁng help
@Installing
.\V/Ar_ﬁvaﬁng Excel

lil| » 1

.{'/Cushomizing
.\V/Accessibility
.\{(/File conversion and compatibility
VSaving and printing
u\“a’orkbook management

.Q"’File recovery

uFiIe management

.g. How daylight saving time (DST) chang
T (71 El:r.[able sunnolrt for other file formatf. =
|

Excel Home

[ | »

Searched for: "How do I save
a file"

Besdisl b ofop 0 Pecs OIT 3 28

'@ Save a file
Help = Workbook management = File
management

@ Automatically save a backup copy of a
workbook
Help = Workbook management = File
management

'@ Demo: Set a password to open or modify
a workbook, document, or presentation =

] — al

Al Excel

3  Click on the most likely an

Step by step instructions are

swer to read the help topic.

displayed showing how to save a file.
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Getting help
Activating Excel
Accessibility

Saving and printing

~ Search
_"?EFC E

General b A g=Insert ~

-"-'_Q Al R B I Delete ~
Styles || n
| %8 578 | - = | Format ~
Mumber s Cells

Number Format
Choose how the values in a cell are

displayed: as a percentage, as
currency, as a date or time, etc,

-gn Press F1 for more help.

':23;/ Office Button

T,

Save As

Find help by category.

Let’s do the same thing now using the category pane. The
category pane is a little like a web page. You find the answer to
your question by navigating a series of hyperlinks.

Close down the help system and re-start it. Look at all of the
categories and decide which is most relevant. See if you can find a
help topic for saving a file by navigating the hyperlinks. On my
system I got there by clicking Workbook Management->Saving
and Printing->Save a File but your links may differ.

The same help topic found earlier is displayed.
Choosing which content to search.

Excel is a huge application and just one help reference wouldn’t be
enough. As well as the help files stored on your hard disk you can
also search a perpetually updating help resource on-line at
Microsoft via the Internet.

Click the drop-down arrow next to the Search button at the top of
the Help dialog.

The Search drop-down menu appears:

2 Search -

@ Content from Office Online

v All Excel
Excel Help These resources

Excel Templates — are aCCQSSEd over
Excel Training the Interne-l—

Developer Reference

d Content from this computer

Bxcel Help | __These resources are
Developer Reference on your hard disk

The Developer Reference contains topics only of interest to
programmers who understand VBA macro code. This is a very
advanced subject and is covered in the Excel Expert Skills book in
this series.

Get help directly from the Ribbon.

1. Click the Home tab on the Ribbon and hover the mouse cursor
over the drop down arrow to the right of the word General in
the Number group.

If you keep the mouse still, after a short delay a screen tip
pops up providing a short description of what the drop-down
list is for and also advising that you can obtain more help by
pressing the <F1> key on your keyboard.

2. Press the <F1> button (at the top left of your keyboard) to
obtain help about topics relevant to this control.

Obtain help directly from a dialog.

Click Office->Save As.

At the top right corner of the Save As dialog there is a help button
It"!] (if you are using Windows Vista).

Click it for detailed help about the Save As dialog.

© 2008 The Smart Method Ltd
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In this exercise you’ll try to remember the name of each of the Excel screen elements. The answers are on the
next page so you might want to recap by turning the page for a little revision before you start.

Keep trying until you are able to name each of the screen elements from memory. We’ll be using this
terminology during the remainder of the book so it’s important that you can correctly identify each element.

A

N ELE :

=]
—/ Home Insert Page Layout FormfQlas Dga Review View

= General i :E:é% :F‘Jdl :;ﬂ: Spmets R }%7 \ﬁ

I Delete - j'
3=|| =5~ (@3- % 9 (|48 ;%8| Conditional Format  Cell

Bookl - Microsoft Excel =

3 * Calibri 11 - A A F

g - ~ Sort& Find &
Formatting = as Table = Styles~ | = Format = || (2~ Filter - Select ~

Font F} Aligrfhent T Mumber T Styles Cells Editing

paste] 2| [ e A

asiel | Al 22l - =

st B /I U H p-s E S
=

Clipbofgd ™

[N RENRE- T R TR

e
RS

b I E 1 | st s e | s
NP ok~ e WM
Il

[

5 5R

]
L5
4

Sheetl - Shest2 - Sheet3 %1 0 | m ] 0
IR E] g )

O -0 o ©

T
o fa
a
=
=

G
©

@

[f you need help
slide the page to
the left
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Ribbon
Office button

Name Box

Quick Access
Toolbar

Active Cell

Formula Bar

Title bar

Column Header

Minimize, Maximize
and Close buttons:
For Excel application —
For this worksheet

FLECEE

Insert

(i)
il

Home

=1 %
B
Paste|

Page Layout

Calibri

Clipbogd = Fant

Pl || A°
Ery
7 ||[BE u-fi-|dh- A FEE=

Formf@las Dga Review

A |3 =]

I Aligrfnent [

I Bookl - Microsoft Excel -1 x

General o

§?| ;53. ||'=)§v % 3 |[%3 ;9| Conditional Format Cell

= ¢

T - y ?E
& :
Sort & Find &

27 Filter~ Select -
Editing

;‘ﬂlnsert ki
j“De\ete £

EjFurmat =

Cells

E WD

Formatting = as Table = Styles -

Mumber I Styles

Wil o b (B W=

1| MR NN R e e e e
AHU\H&I&’NHD\DW“—JU\E&UBMHO
x

Sheetl -~ Sheet? . Sheet3

=

v
w
=

=

: e

Sheet Tabs
Row Header

Tab Scroll Buttons

— New Sheet
tab

|
Status Bar View buttons

Scroll Bars

© 2008 The Smart Method Ltd

55






